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APPENDIX 17

(The attached SOP includes Attachment A: Ocean Surveys, Inc. Manual of Standard Operating
Procedures. This attachment contains SOPs for the operation and calibration of navigational
and geophysical survey instrumentation. Not all of the SOPs included in this attachment apply
to the Side Scan Sonar Survey SOP.)



GENERAL ELECTRIC COMPANY GEOPHYSICAL STANDARD OPERATION PROCEDURE
HUDSON RIVER DESIGN SUPPORT

SEDIMENT SAMPLING AND ANALYSIS PROGRAM

REVISION NO: 2

DATE: September 6, 2002

STANDARD OPERATING PROCEDURE FOR
SIDE SCAN SONAR SURVEYS

1. Side scan sonar activities will occur over a two to three week period on the upper Hudson
River from Rogers Island to Federal Dam in Troy. Since this is a well-traveled navigational
channel, the work will be coordinated with the Canal Corporation, as required by the Health
and Safety Plan and the Community Health and Safety Plan. In addition, the sampling

vessels will maintain contact with the Canal Corporation using marine band channel 13.

2. The side scan sonar survey will utilize GPS receivers (Trimble 7400 MSi) to acquire
navigation data using shore-based reference stations with known coordinates and elevations.
Differential correctors determined at these stations will be transmitted to the survey vessel
where they will be used by the onboard receiver using Real Time Kinematic OTF software
to determine the accurate position of the GPS antenna in the vertical and horizontal planes.
These data will be logged on board at one-second intervals for the duration of the survey.
Data quality parameters will also be logged and monitored by the onboard navigator with
flags put on all data points which do not meet the quality limits set. The specified accuracy

for this system is +/- 2 cm when satellite configuration is sufficient.

3. Before leaving dock, the side scan survey crew will check to make sure all navigation and
instrument systems are working properly. Calibrate and set navigation instruments based
on the instrument-specific standard operating procedures (Attachment A). Prepare survey
equipment for start of daily survey operations including: deployment of side scan sonar tow
fish into water, measurement of survey equipment offsets, daily speed of sound test, and

other required pre-survey activities.
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4. Navigate to coordinates of first transect. Transect coordinates and headings — the trackline
-should be based, wherever possible, such that the vessel intersects as many Sediment
Sampling and Analysis Program (SSAP) coring locations as possible during side scan sonar
survey. SSAP sediment coring coordinates will be provided to the side scan sonar crew for
import into the navigation computer. A Coastal Oceanographics “Hypack Max” will be
used for trackline design, navigation, trackline control, and digital depth and RTK DGPS
data logging.

5. Align survey vessel along longitudinal transect and confirm autopilot heading and operation.
Start data acquisition and commence side scan sonar survey along transect. Conduct the
side scan sonar survey using a high resolution side scan sonar system (Klein Model 595)
with a dual frequency (100 and 500 kHz) tow fish. Export and log the side scan sonar
imagery to the ISIS data acquisition platform. Enter all system annotations in the ISIS XTF

notes field.

6. Use a digital depth sounder to collect water depth information along each transect. Log

depth data to the Hypack Max system.

7. During the survey, perform periodic manual probing and visual characterization of
sediments. Note coordinates and results of probing or characterization in the field log. Note
coordinates of areas that may need additional confirmatory sampling and sediment grain

size analysis to ground-truth the side scan sonar data in the field log.

8. Note relevant observations and changes in operational procedures to the field log. These
may include: coordinates of observed obstructions or artifacts; areas where interferences or

other conditions limit survey resolution or prevent bank-to-bank coverage; and coordinates

QEA, LLC/Environmental Standards, Inc. Page 3 of 47
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where adjustments to tow fish height, line spacing, or range scale are made.

9. Atthe end of each transect, confirm successful data acquisition and storage, navigation and
equipment calibrations and settings. Log time and coordinates at end of each transect line

surveyed.

10. Prepare equipment for navigation to next transect; navigate to next transect.

11. Repeat steps 4-10 for collecting data along a transect until bank-to-bank coverage has been
achieved in each survey section. A line spacing of no more than 250 ft should be used and
at least two transects — one on either side of the river — should intersect numerous SSAP
sediment coring locations. Above and below dams, survey bank-to-bank along a lateral
transect maintaining a safe operating distance (as determined by boat operator) from the

dam and cautionary buoys

12. All raw survey data and information (e.g., field notes, instrumentation frequencies) must be
documented electronically or in a field note book. At the end of each day, check daily
computer data from the Hypack Max and ISIS systems for error flags. Output all notes to
an ASCII file and store with the raw records. Back-up copies of the raw electronic data and

make copies of all field log entries.
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1.0 INITIAL EQUIPMENT SETUP

This is a draft document. The most recent modification was on 07/31/02 by MLK. New versions
will be distributed as they are created.

There are presently several documents that are associated with this that are not included at this

time.

B NS R

Caris offset drawing

Hypack offset drawing

System wiring document

System comm. Port settings and data formats

1.1 General Tasks Before Start of Survey

Notify GE of vessel movement
Obtain permits for movement through and between locks
Obtain proper charts and update with all Notice to Mariners
Verify availability of CG DGPS correctors and RTK stations
Document equipment installation

o Establish Boat 0,0,0

Vessel fore/aft centerline, aft edge of athwart ship [-Beam on A-Frame,
point on aft deck slightly above waterline

o Measure and record all offsets

Trimble 7400 MSi DGPS’s
e Navigation antenna X, Y, Z
e Reference antenna X, Y, Z

Trimble 7400 RTK GPS
e Antenna to waterline
e X &Y toboat0,0

Innerspace 448 X, Y, Z

TSS DMS 2i-05
e X, Y,Z
e Zero out mounting angles with appropriate vessel loading — see
procedure in TSS section

Robertson Compass
e XY

Ocean Surveys, Inc.
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e Align to true heading of vessel centerline — see procedure in

Compass section

=  Sidescan Tow Point X, Y, - Z left at 0.0 m for proper Caris import of

layback

= Subbottom Profiler Tow Point X, Y, - Z left at 0.0 m for proper Hypack

import of layback

1.2 Equipment Setup

. 1.2.1 Trimble 7400 Receiver
= Initial Settings
e RTCM Output = off
e RTCM Input
o Inputs ON

Port=2
Format = USCG
ASCII Printout off
Beeper Off
Station = any
Age Limit 20 sec.

o Integrity Monitor Off
e Power Up Control

o Do not default controls at power up
e SV Enable/Disable

o Disabled mode = none
e Adjust local time

o Time offset EDT-UTC = -4 hrs

o Time Zone Identifier = EDT
e Baud Rate Format

o Port 1 =9600-N-8-1

o Port2=9600-N-8-1
e Remote Protocol

o Data Collector Compatible
e Reference Position

o Lat=355040.91718

o Lon=0753919.57021

o Height =-37.529

O O O OO0 O

Ocean Surveys, Inc.
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o (Note, may be changed during survey by selecting HERE
to get local position and current ellipsoid height for Lat/Lon
— Fixed height)
e Masks/Sync Time
o Elevation Mask = 8
o PDOP Mask =5
o SV Sync Time = 1.0
e Positioning Modes
o Weighted solution enabled
e Lat/Lon Height Always
=  Power Controls
e (Charger and Power output disabled
= NMEA 183 Output
e Port 1 Enabled
o GGA, VTG, ZDA
= (Cycle Printouts = Off
= ] pps output = disabled
= Default controls — DO NOT USE!!! RESETS TO FACTORY
*  Modify
e Units of Measure
o Lat/Lon Degrees = Deg.Min.Sec.
o Time =24 Hr UTC
o Position = WGS-84 LLH
e Altitude Reference
o Height above ellipsoid

1.2.2 MX-51 Beacon Receivers

= Initial Settings - DGPSI1

e HUDSON FALLS, NY
Status: Operational
RBn Antenna Location: 43° 16.21' N73° 32.31'W
REFSTA Ant Location (A): 43° 16.2491' N73° 32.34705' W
REFSTA Ant Location (B): 43° 16.2637' N73° 32.34534' W
REFSTA RTCM SC-104 ID (A): 94
REFSTA RTCM SC-104 ID (B): 95
REFSTA FIRMWARE VERSION: RD00-1C19
Broadcast Site ID: 844
Transmission Frequency: 324 KHZ
Transmission Rate: 200 BPS
Signal Strength: 100uV/m at 135NM

Ocean Surveys, Inc.
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=  CTToolbox should be used to reload HI11032R.CNF (config file) if
necessary. The following settings are in HI1032R.CNF
e CONTROL/BASE STATION
o Input using HERE at Hudson Falls
o LAT 355040.77420
o LONO0753919.81768
o HGT-0035.870
o ANT Height 000.000
e CONTROL/SV ENABLE/DISABLE
o ALL-ENABLE
e CONTROL/GENERAL CONTROLS
o ELEV. MASK: 08
o PDOP MASK : 05
o MEAS RATE 1 HZ
o MOTION: KINEMATIC
e CONTROL/POWER CHARGER
o POWER OUTPUT MODE DISABLED
e CONTROL IPPS OUTPUT
o 1 PPS OFF
o ASCII TIME TAG PORT OFF
e CONTROL SERIAL PORT OUTPUT
o NMEA/ASCII OUTPUT
o GGK
= PORT?2
= 1HZ
o ZDA
= PORT?2
= 1HZ
o All others off
e STREAMED OUTPUT
o ALL OFF
e RTI17/BINARY OUTPUT
o ALL OFF
e CMR/RTCM
o BASE - MOVING
o CMR PORT - OFF
o NAME - cref
o RTCM PORT - OFF
o TYPE-1
e CONTROL/SERIAL PORT SETUP
e PORTI 9600 8-NONE-1
e PORT 2 9600 8-NONE-1 NONE

Ocean Surveys, Inc.
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1.2.3 Compass

e PORT 3 9600 8-NONE-1

e PORT 4 9600 8-NONE-1 NONE
CONTROL/INPUT SETUP

e USE RTCM STATION — ANY

e RTK/DGPS AUTO SWITCH RANGE —-20.0 KM

= Initial Calibration Procedure

Load vessel, as it will be for survey ops. Remove any large ferrous
objects from the vicinity of the compass.

Position the vessel in open water

Apply power to the Robertson autopilot

Begin by turning the vessel to starboard.

Select INSTALLATION/RFC COMP calibration.

Calibration should complete after ~ 1 4 turns and should be
verified by a display of Calibration confirmed.

= Determine and apply Compass Offset

1.2.4 TSS DMS 2i-05

Con the vessel on a straight line while observing the heading
computed by the GPS system.

Adjust the offset by turning the autopilot knob to match the pilot
compass heading to the gps heading. Note the applied offset. (This
puts the pilot compass into “TRUE” heading.)

= Initial Settings

Set baud rate/format to 19200,N, 8,1
Heave bandwidth = SHORT
Output Rate = 50 hz.
GPS data input settings = NMEA Local 9600, 8, N, 1
o Check GPS RAW and CALCULATED input
GYRO data input settings = NMEA Local 4800, 8, N, 1
o Check Compass RAW & CALCULATED INPUTS
Data output format = TSS1 19200, 8, N, 1
Zero out mounting angles. Document mounting angles with screen
grab.
o Stabilize vessel with static loads approximating those that
will be experienced during the survey.
o Access TSS through communication program and set
mount angles automatically by averaging data for 5 minutes
o Accept values and screen grab settings

Restart TSS operation and exit from program

Ocean Surveys, Inc.
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Mount Angle Setting Recorded
06/04/02

DHMS 7-05 Version 2.03 Terminal Mode

Senzor Mounting

COrientation : Vertical

Foll Mount Angle [ 1.741 deg]
Fitch Mount Angle [ 1.711 deg]
Yaw Mount Angle [ 0.000 deg]

= Do Not Change These Settings!
[ ]
1.2.5 Innerspace 448
= Initial Settings
e Verify the following initial settings
o Gain = Approx. 10 o’clock setting
Range =0-15 M
Mode = Meters
Chart Speed =4
Range Multiplier = X1
Input default speed of sound of 1500 m/s
Set draft = 0.0
Tide=0
Initial = 5
Gate =2
Mode = Gated
Reply =16
Alarm on during survey
Set variable power TX board to Low, to limit interference
with SS and MB
Set internal TVG curve switch to open/open or +60 db.
This was needed to receive quality data at the above
mentioned low power setting with our combination of
components
o Set date & time — See back of paper carrier
o Load paper per picture on back of paper door

O OO0 O0OO0OO0OO0OO0OO0OO0OO0oOO0oOOo

O

1.2.6 Klein 595
= Initial Recorder Setup

Ocean Surveys, Inc.
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Set system to factory defaults by pushing left button on the CPU
board
= This resets all values to factory default
= Jtalso resets all gain curves and other “adaptive
controls prior to calibration
e A calibration should be preformed, per the
manuals description any time a component
is changed, like a cable or fish
o Set time/date in submenu
= Add “*” to time and date to print it when an event is
pressed. This can be used to log tuning changes and

rub tests
o Set system to the following values:
= Auto CPU

e Altitude=0,0
e Return=10

o Offset=2
=  Auto TVG Port

e Normal

e Atten.=9

e Salt Water
= Auto TVG Starboard
e Normal
e Atten=9
e Salt water
=  Printer = Off
= Range=25 Add “*” to field
= Scale lines=10 Add “*” to field
=  Source = Fish
= Channel=1 |2
= Speed =Manual —1.0 Set to avoid alarms
= Altitude = Auto
=  Mapping Mode = Off
= Altitude Alarm = Off
= Auto Mark = Off
= Event Count = Off
= Event Mark = Off
= Side Scan Expand = Off
= Profiler Expand = Off
= Nav Source = Nav3* - used for external Eventing
option

Ocean Surveys, Inc.
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e Follow the calibration found in the operations manual on 3-34 to
tune for site conditions
e Document tune-up settings in SSS annotations
e Document tow configuration and Cable out in SSS annotations
o Tow Point
= See attached drawing for exact location
= The tow point is a sheave mounted to a bowsprit. In
operation the fish is lowered tolmeter in the water
as the vessel is moving at survey speed.
= The cable is fair leaded back to the stern on the
outside of the bowsprit mount. Cable out
measurement is taken from the point of the sheave
closest to the mount point
= The layback was measured by observing the fish
under survey conditions and measuring from the
center of the xducers to the tow point.
= Document any changes made to the recorder online
in the Isis notes section
e Initial Fish Setup
o Depression angle = 20 degree’s
o 500 KHz only
o 100 KHz disabled in fish — SCR trigger is disconnected.
o Attach depressor to fish

e Internal Jumpers

o A/D board jumpers should be set to reflect proper software
version (checked 050202)

o Fish Tape I/O jumper should be set to either 15v for short
cable or 24v for long cable (winch) (checked 05/2/02 set to
15v)

o Verify which channel is tracking altitude on the Connector
interface board

1.2.7 Bar Check
= Initial Setup and Calibration
e Determine maximum depth of survey and depth units
o Sheet A maximum depth is in the 10 meter range
o Survey depth units are meters
e Construct Bar Check per OSI standards
e Typel
= .2 meter diameter lead disk with eye bolt
= Imprint a “serial number” onto bar
o “A”

Ocean Surveys, Inc.
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e “B”
= Coated aircraft cable
= Brass marker beads at appropriate intervals
e Minimum of every 1 meter throughout the
survey depths
e This is to allow use of a “pocket rod” to read
inter bead values
= Also mark cable on both sides of bead with a
“sharpie” to help identify bead slips
= Measure bead locations with steel tape to the
nearest 0.01 meter increment
= Record bar s/n and all other information required on
OSI Lead Line Calibration form
o Recalibration
= Recalibrate Bar Check every 6 months, or after any
action that could possibly affect the condition of the
Bar Check, such as snagging line on bottom.
= Recalibrate at the completion of the survey
o Maintenance
= Periodically examine the eye bolts and cables

e Typell

=  Aluminum square-beam > width of boat with target
at position of in hull xducer

= Imprint a “serial number” onto bar

= Coated aircraft cable

= Brass marker beads at appropriate intervals

*  Minimum of every 1 meter throughout the survey
depths

e This is to allow use of a “pocket rod” to read
inter bead values

= Also mark cable on both sides of bead with a
“sharpie” to help identify bead slips

=  Measure bead locations with steel tape to the
nearest 0.01 meter increment

= Record bar s/n and all other information required on
OSI Lead Line Calibration form

o Recalibration

= Recalibrate Bar Check every 6 months, or after any
action that could possibly affect the condition of the
Bar Check, such as snagging line on bottom.

= Recalibrate at the completion of the survey

o Maintenance

Ocean Surveys, Inc.
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1.2.8 GE 1 Computer System

= Start Up

o Periodically examine the eye bolts and cables

e Verify DC Mains and Autopilot are off before powering up, or
logging onto, system

e Log on using default Logon

o User Name osiuser

o Password (blank)

= Verify time zone is set to (GMT) Greenwich Mean Time: Dublin,
Edinburgh, Lisbon, London.

= DO NOT CHECK “Automatically adjust clock for daylight savings time.

= Start HyPack MAX with appropriate shortcut

o Open new project named GE-1
Create folders in the project folder named DATAI
Set geodesy to UTM Zone 18 WGS 84

HYPACK HARDWARE SETUP
e New File
e NAV-NMEA183.DLL
o Name = DGPSI1
o Update Frequency = 50ms
o Type
=  Position
o Options
= Record raw data
= Record quality data
o Record
= Always
o Connect
=  Serial Port
e (COMS3, 9600,8 none, 1,Flow
Control = none
o Offsets
= Starboard = -.35
= Forward =+ .23
= Height =+1.97
= Latency = 0.860
o Setup
= Standard NMEA 0183 sentences to be

used

Ocean Surveys, Inc.
GE Hudson River Geophysical SOP

Page 12



OCEAN SURVEYS, INC.

e GGA
= HDOP Limit = 2.5
®*  Minimum Satellites = 4
= Use ZDA message for time tag =
Disabled
= Send alarm when non differential

Depth — Innerspace 448 {Serial} - IN448.DLL

o
o
o

O

Name =448
Update Frequency = 50
Type

= Echo sounder
Options

= Record raw data
= Record quality data
=  Paper Annotation
Record
= Always
Connect
= Serial Port
e (COMS6, 9600,8,none, 1
Offsets
= Starboard = 0.0
= Forward =0.0
= Height =+.8 NOTE!!! .8 meters used
as “display offset”. See Draft
explanation
= Latency = 0.000
Setup
=  Send annotation string with event mark
= Multiply not needed

Auto Pilot Compass — NMEA.DLL

o
o
o

Name = AP Compass
Update Frequency = 50

Type
= Heading
Options

= Record raw data
= Record quality data
Record
= Always
Connect
= Serial Port
e (COMS5, 4800,8,none, 1

Ocean Surveys, Inc.
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o Offsets
= All zero
o Setup
= Sentence to be used
e HDG
e Auto Pilot — NMEA.DLL
o Name = AP XTE
o Update Frequency = 500

o Type
= Qutput
o Options

= Record raw data
= Record quality data
o Record
= Always
o Connect
= Serial Port
e (COMS, 4800,8,none, 1
o Offsets
= All zero
o Setup
= Sentence to be used
e GGA
Sentence to generate
APB
GLL output places = 4
XTE (Nautical Miles) checked
Output to hundredth decimal place = Enabled
XTE Factor = 0.0

O O O OO0 O

e File Server — Delph Output — DELPH.DLL
o Name = Isis Out
o Update Frequency = 20000

o Type
® (nothing checked)
o Options

= Record raw data
= Record quality data
= Paper Annotation
o Record
= Always
o Connect
=  Serial Port

Ocean Surveys, Inc.
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e (COM7,9600,8,none, 1
o Offsets
= All Zero

e TSS DMS2i-05 — TSS320.DLL

o Name = DMS2i-05

o Update Frequency = 50

o Type
= Heave Compensator
= Other

o Options
= Record raw data
= Record quality data
= Paper Annotation

o Setup

= Motion reference Unit Only
o Connect

= COM 19200,8,N, 1
o Record

= Always
o Offsets

= Position

= Starboard = -.44

» Forward = +.47

=  Vertical =-.18

= Yaw=0

= Pitch =0

= Roll =0

= Latency =0

e Trimble 7400 RTK OTF - KINEMATIC1.DLL
o Name - RTK
o Type
= Position
= Echosounder
= Sync. Clock
= Tide Gauge
o Record RAW
o Record Quality
o Setup

Ocean Surveys, Inc.
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Kinematic GPS Setup I

— Meszages
- M GGA W PTNLO&A [ GxP
™ GLL W PTML. GGEK

I GGE T wIG

—GPS Mode

Iwalid b &
Stand Alone I‘I— v '
"~ | Differential -  ~
FKinematic 3 ' '
|DGPS |4 V¥

— Time T agging kethod
Z | & UTC Time . PPS i~ Software

[ Ignore checksum
Select KTD File ... Cancel |

o SELECT KTD FILE
= File 02ES007.KTD used for survey ops

o Connect

= COM29600,8,N, 1, Flow Control = none
o Offsets

= Position

= Starboard =-1.50

= Forward = +.25

= Vertical =+ 2.05

= Yaw =0

= Pitch =0

= Roll =0

= Latency =0
o Record

= Always

o Create a second mobile named RTK. Transfer the RTK
device to the second mobile
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e URS-1-VHW.DLL
o Name = Speedlog
o Update Frequency = 200
o Type
=  Speed
= Other
o Options
=  Record raw data
= Record quality data
o Setup
" none
o Connect
= COM 94800,8,N, 1, Flow Control = none
o Record
=  Always
o Offsets
= None
e Settlement — DraftTable.dll
o Name = Settlement
o Update frequency = 100
o Type
= Draft
o Setup
= (Create Draft table from Settlement and Squat test
= Insert Draft table picture — set to 0.0 for squat test
o Offsets
= None
o Connect
= Jgnored
o Record
= Always

1.2.9 GE-1 CARRIS OFFSETS to BOAT

DGPS1 (NMEA183.DLL)

STBD +1.18
FWD +0.02
Height +1.97
Latency +0.00

448 (INN448.DLL)
STBD +1.53
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FWD -0.21
Height +0.80
Latency +0.00
Auto Pilot Compass (NEMA.DLL)
STBD +0.00
FWD +0.00
Height +0.00
Latency +0.00
Isis Output (DELPH.DLL)

STBD +0.00
FWD +0.00
Height +0.00
Latency +0.00
Auto Pilot (NEMA.DLL)

STBD +0.00
FWD +0.00
Height +0.00
Latency +0.00
DMS 2i-05 (TSS 320.DLL)

STBD +1.09
FWD +0.26
Height -0.18
Latency +0.00
RTK GPS KINEMATIC.DLL
STBD +0.03
FWD +0.02
Height +2.05
Latency +0.00

1.2.10 Other Hypack Max Settings
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'—'L“ Hypack - Geodetic parameters

File  Dptionz  Help

— Predefined

rids

T Horth

Zone | Zone 18(78w-72w) =
Distance unit I M eter j
Diepth unit IMeter j
Elipsoid  [wG5-84 =l

Semi-major axis

IES?B1 37.000

Flattening (1] [29e 257223853
Geoid Madel | =]

Orthametric height corection Q.00

Ok |

HE|

Frojection ITransverse Mercator j
Central Meridian ID?E‘”DD'DD.DDDD'W
Reference latitude IEIEI"EIEI'EIEI.EIEIEIEI“N
Scale factar ID.EIEIEIEEIDDEIDD

Falze E asting [<] IEEII:IEIEIEI.EIEIEIEI

Falze Horthing [7] IEI.EIEIEIEI

— Diatumn tranzformation parameters

Delta & IEI.EIEI Delta = IEI.EIEIEIEIEI
Delta IEI.EIEI Delta rv' IEI.EIEIEIEIEI

Delta 2 IEI.EIEI Delta r2 IEI.EIEIEIEIEI

Delta Scale IEI.EIEIEIEII:I Wz EEEEEEE

Draturn zhift file I

|

I | Lol GrdSdiustment [Cereal G

Cancel |

|

Project Data

|

Project ¥ Ovenide Froject Path

Job |0z 5007 [D:\Hypack\Projects\HT1 | .|
Area [PaMLICO SOUND NC | /| Overide Target Path

Boat |F wILLING Il [D:\Hypack \Projects\H1T | .|
Surveyor IFES'W' RJS

" Standard HYFALCE Filenames
¥ Long Filenames
{~ CHS Filenames

™ lulian Day az Extension

™ Other Extension I

o]

Cancel
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NOTE: XTE ALARM set to 100000 for Sea Trials

Mavigation Parameters EH |

Start line gate
ATE Alarrn limit
Mext event
Ewvent interval 2000
Event increment

M ext line

Line incrernent
LOG Backup Time
M T Backup Time
Rowxann Sound Wel,
Min Depth

T

[T Reset Events on Startup
[ Time Events on Even Intervals

[T Connect Events with Segments

— Ewvent basis
" Manual
* Time
" Distance

—Automatic leg switch—
& Wwhile logging
™ Always
" Mever

— Line Direchion Maode—
% Closest point

" Origin poirt
' Teminus paint

" Alternate points

(] I Cancel |

i Default Target Paramet. .. |

Digplay coordinates as:

™ Lat/Lon [deg. min. sec.]

¢ Lat/Lon [deg.min.]

Ma. af circles |1
Fadiuz increment |5|:|_|:||:|

¥ tarking T argets does not
produce Events

[ Mo Default Hame

k. I Cancel

o 1.2.11 ISIS

o Start Up
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= Verify DC Mains and Autopilot are off before powering up, or logging onto, system.
Note: if monitor does not come on (yellow power/signal indicator steady yellow on
lower right corner of monitor) remove power from monitor for a few seconds, then
restore and turn on monitor.

= Start Isis with Isis H11032 shortcut — Only
o This calls up a specific configuration file

o File types and locations

= H11032 ISIS Short Cut to Start Isis Desktop

= HI11032.LAY Window Layout E:\H11032 ISIS\H11032 Config\
= H11032 140.CFGlIsis configuration file D:\TEI\IsisSona\v5.91\

=  Survey. log Isis session log D:\root

e Note: unable to redirect this file

o Initial Processor Settings
= File Menu
e Playback N/A
e Record Setup
o Sonar Setup
=  Pick standard analog
= Select CHICO/CHICO PLUS Board
e Channel 1 edit
o Status = On
o Name = Port
o Type = Port SSS
o Trigger=1
e Channel 2 edit
o Status = On

o Name = Stbd
o Type = Starboard SSS
o Trigger=1

All other channels disabled
Sonar name to H11032 Klein 595 2 CH 500Khz
Frequency = 384.0,384.0
Horizontal Beam Angle =0.2,0.2
Beam Width = 50.0, 50.0
Tilt angle = 20.0, 20.0
Name of server = ISISCHICO.EXE
Automatic control disabled
Heave, Pitch, Roll
Status = On

o Serial Port

e — & o o o o o o o

Ocean Surveys, Inc.
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o Serial Port 2
o Serial Port 3

[
[
[ ]
[ ]
[ ]
o Serial Port 4
[ ]
[ ]
[ ]

[ ]
[ ]
[ ]
o Serial Port 5
[ ]
[ ]

Settings = 19200, 8, N, 1
Template = TSS
Convert Lat - Long = Disabled
Filter Speed = Disabled
Navigation Latency = 0.0
Not used
GPS for SSS
Status = On
Settings = 9600, 8, N, 1
Template = NMEA0183 NOCLOCK
Convert Lat - Long = Disabled
Filter Speed = Disabled
Navigation Latency = 0.0
GPS for Single Beam
Status = On
Settings = 9600, 8, N, 1
Template = NMEAO0183
o NMEAO0183 SHIPPOS NOVTG
Convert Lat - Long = Disabled
Filter Speed = Disabled
Navigation Latency = 0.0
Compass
Status = On
Settings = 4800, 8, N, 1
Template = NMEA0183 NOCLOCK NORMC NOGLL
NOVTG
Convert Lat - Long = Disabled
Filter Speed = Disabled
Navigation Latency = 0.0

o Serial Port 6 May be used for Fish Altitude input
o Better Tuning Has Made This Option Unused

=  Manual SSS Bottom Tracking Option
Status = Off
Settings = 9600 8, N, 1
Template = Manual
o Modify Default = {/100} {-1.3}7
e (Change 1.3 to value needed to get correct
altitude
Convert Lat - Long = Disabled
Filter Speed = Disabled
Navigation Latency = 0.0
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o Serial Port 7

[ ]
[ ]
[ ]
o Serial Port 8
[ ]
[ ]

Hypack feed for Line Control
Status = On
Settings = 9600, 8, N, 1
Template = (Leave Blank)
= Allows events and start/stop info in from Hypack
Convert Lat - Long = Disabled
Filter Speed = Disabled
Navigation Latency = 0.0

448 feed to Aux Sensor 1
Status = On
Settings = 9600, 8, N, 1
Template = Manual

o Modify Default = {/100} 1
Convert Lat - Long = Disabled
Filter Speed = Disabled
Navigation Latency = 0.0
Serial Port 9 RTK INPUT

o Serial Port 10 Speed Log

e File Format
Format = XTF

Media = Disable

Sample Size to Record = 16 bit
Samples per Channel = 1024
Processing Method = MAX
XTF File Header Notes

Status = On

Settings = 4800, 8, N, 1
Template = {pattern=m}s
Convert Lat - Long = Disabled
Filter Speed = Disabled
Navigation Latency = 0.0

e Vessel Name
e Survey Area

e Operator

e Configure

= Playback Speed — as desired
o Real Time Scrolling
= Scroll without restoring covered data
o This keeps system from locking up
o Transducer Depth = 0.0

o Ocean Tide
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= Apply Corrector = Disabled
= Verify=0.0
o Sound Velocity = Average from first cast of the day
o Multiple Pings =1
o Hypack DDE
= Accept from Hypack = Disable All
= Automatically Start Saving At Start of Line
o Use File Name from Hypack = Enable
o Generate File Names = Disable
o Start Each File with = Enter Daily Directory Info
o Cue Boxed = Disabled
o Set Date and Time = Ignore — Will be automatically set during
operation
o Save Setup = Prompt User at Exit

e Color
o Palette
= SSS Colors = Grey Scale
=  Squelch =0.0
= Reverse Palette = Enabled
= Strong Returns Red = Disabled
o Grid Color
= Voltage Grid
e Line = Blue
e Data = White
e Dim = Both Enabled
= Scale Lines Red

o View
o Scale Lines
= Apply Settings to = All the same
= Scale line Unit = Distance
e Spacing=10
o Depth Delay and Duration
= Apply Settings to = All the same
= Units = Off
o Overlay
=  Show on Waterfall
e Event Marks = Disabled
e Event Text = Disabled
e Bottom Track = Enable
=  Bookmarks

Ocean Surveys, Inc.
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e Save Bookmarks = Enabled
e Display Bookmarks = Enabled
o Down Sample = Max
o Speed
* Automatic = Enabled
= Filter = Disabled
o Heading = Automatic
o Layback Correction
= Apply Delta XY = Disabled
= Apply Layback = Enable
e Use Logged Layback = Disabled
Enter layback manually = Enabled
Compute layback from Cable Out = Disabled
Enter layback value in box provided (Currently 1.0M)
o This field with be empty, enter value
= Obtain value from chart
Click ACCEPT, current value changes to entry
NOTE: DO NOT CLOSE WINDOW
NOTE: CHECK AT START OF EACH LINE
NOTE: HAVE OPEN DURING CONTACT
PICKING

O O OO

o Tools
e Target Setup
o TargetPro.exe only
e Target Setup
o Height=512
o Width=2048

o
= Target
o File
= Set working Directory = Enter Daily Data Directory
o Tools
Configuration
Speed auto

Speed Corrected display = yes
Layback = manual
Horizontal beamwidth
e Manual, 0.0
= Local variation = 0.00
= Latitude/longtitude
e Deg Min Sec
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= Northing/Easting Display

e Meters

= Range Display Units
e Meters

=  Speed display Units
e Knots

= Misc.

e Automatic Audit Trail = yes
e Object Detection on image load
o None
= Units = Meters
= Constants = Use defaults
= Set Contact Number = Start with 1 — Ensure number is
consistent with contacts logged to date.

= Speed Correct = Enabled

=  Parameter Window — Current File Section
e Switch Button
o Record Data to File Name = Blank
o Remaining storage = Enable D: and E:
o File Grows larger than = Disable

Altitude - Absolute
Based on 595 Range Scale

20%
Maximum
Range 8% Minimum Altitude Altitude

25 2.00 5.00
Maximum System Speed
Based on 595 Ping Rate

Range Ping Rate / Second (Measured) Maximum Speed (Knots)
25 27.00 17.50

Maximum Survey Speed

Based on 10% Buffer
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Range Maximum Speed (Knots) |90 %Maximum Speed (Knots)
25 17.50 15.75
. 1.2.12 Robertson Autopilot
Introduction:

The factory technical representative for the parent company Simrad, is Rich Barnes (425-778-8821)
who is located at Simrad, Inc., 19210 33" Avenue West, Suite A, Lynwood, WA. 98036. The pilot
was interfaced to NOAAI1 to receive NMEA (modified) standard messages from Coastal
Oceanographics HYPACK MAX Survey program. The vessel captain performs all operations related
to the pilot.

Interface:

The pilot receives the following NMEA-0183 messages;

APB (modified by Coastal to send .#### nm of cross track error vs. .## nm, the NMEA standard)
VTG (standard)

GGA (standard)

Baud rate is 4800/N/8/1

NMEA input to the pilot is through TB 10 on the Junction Unit, Pins RX 1(+) and RX1 (-). There
is no handshaking or error correction used. The Robertson RFC35R rate compass is used to provide
vessel heading to all systems and outputs a NMEA message through TB10on the Junction Unit, Pins
TX2(+) and TX2(-).

Operation:
The pilot starts in the Helmsman mode. The captain steers the vessel on to the trackline well ahead

of the actual BOL and attempts to track down the line. When the vessel has stabilized online the pilot
is put into the Auto mode. The pilot is “course steering” at this point. The captain observes the
vessel motion and line tracking while adjusting the “course” using the left/right buttons on the
control unit or remote control. When the vessel is steering the line and cross-track error has been
reduced to a minimum (typically less than 1 meter), the captain changes to the NAV mode. The pilot
will continue to steer in “course steering” mode for a period of time determined by an internal setting
(currently at minimum — 100 sec). Then it will use the XTE value received from HYPACK MAX
and attempt to adjust it’s course to achieve zero XTE.

Some conditions prohibit the use of the NAV mode. One example is the use of a drogue chute to
slow the vessel. Sea conditions that cause sudden large heading changes are another example. In
these cases the pilot is left in the Auto mode and the left/right buttons on the control unit or remote
control unit are used to con the vessel down the line.

Initial Setup:
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Mechanical setup and alignment are performed at the time of installation and should require no
further adjustment. There are many electronic settings that affect pilot operation. They fall in to
several categories:
e Front Panel
o Rudder — used to set the amount of rudder used by steering commands
o Counter Rudder — used to set the opposing rudder used when crossing a course
line
o Weather — used to reduce pilot sensitivity in heavy seas
e Info Loop
e Weather Loop
e Debug Loop
Normally, only the Rudder setting is changed throughout the day. More rudder (higher #) causes
closer tracking and quicker steering response. Too much rudder causes large heading swings. Too
little rudder and the vessel will fail to closely follow the line.

2.0 PRE SURVEY OPERATIONS

2.1 Navigation System Check

Upon arrival in Hudson Falls a third order control disk will be located to facilitate the performance
of a navigation confidence test. Two separate procedures will be performed. The first procedure is
to determine the horizontal and vertical position of the project RTK GPS base station and certify it.
The second procedure involves using the Trimble 7400Msi L!/L2 Kinematic OTF system to locate
a check point in proximity of the survey vessel for future confidence checks.

The first procedure involves the following.
A RTK base will be set up with it’s antenna positioned at a known height over a GE/QEA supplied
point. The Trimble 7400Msi reference receiver is then configured to provide CMR correctors based

on the following parameters.

Configuration Toolbox file D24 Base.cfg
1. Generate CMR correctors on Port 1

2. Kinematic base unit

3. A elevation mask of 13 degree’s

4. A PDOP mask of 5

5. Reference position of 35 50 40.87561 Lat, 075 39 15.38597 Long, -37.75 Elev.
(WGS-84 Ellipsoid height)

6. Antenna height set to 2.000 meters, Antenna mounted on a 2.00 meter rod

7. Antenna type set to L1/L2 compact resulting in a True Vertical Height of 2.062

meters

Ocean Surveys, Inc.
GE Hudson River Geophysical SOP Page 28



OCEAN SURVEYS, INC.

The project RTK base will be set up as a rover station, receiving corrections from the station set
at various stations using the following parameters:

Configuration Toolbox file RTK ROV.cfg
1. Receive CMR corrections on Port 1

2. Kinematic rover

3. A elevation mask of 13 degree’s
4. A PDOP mask of 5

5. Output GGK on Port 2.

For reference, the RTCM-104 correctors will be relayed from the reference station to the project
base station location with Pacific Crest Radio Modems Model RFM96W.

Finally, a Hypack Project will be setup to monitor the position in both WGS-84 Lat, Long and
UTM Zone 18 NAD-83. The following parameters will be used.

1. Project =Base Average

2. Kinematic DLL for GPS input configuration

3. System offsets were set to 0,0,0 for this test

4. Geodesy was set for the above listed UTM Grid.

Position observations will be recorded for a sixty minute period. These observations will then be
averaged and assigned as the project RTK base stations horizontal (WGS-84 Lat Lon) and vertical
elevation (WGS-84 Ellipsoid).

The project RTK base will then be set up as a reference station, sending corrections based upon the
assigned position. The following parameters will be used:

Configuration Toolbox file BASE.cfg
1. Generate CMR correctors on Port 1
Kinematic base unit
A elevation mask of 8 degree’s
A PDOP mask of 5
Reference position of Lat 35 50 37.98404 N, Long, 075 39 15.87987 , -23.826
Elev. (NAVDSS)
6. Antenna height set to 000.00 and antenna type set to UNKNOWN (0.0 offset)

il

The data from each file will be processed through SB-MAX where it will be filtered to only GPS
Mode 3 points with an HDOP of <=2.0. These values will then be averaged and also the min & max
values will be observed.

2.2 Static Draft Measurement
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. Establishment of Vessel Reference Position

Prior to survey operations, a Vessel Reference Position was set for use in post processing. Survey
data will be collected by an Isis v5.91 system for processing under the Caris HIPS/SIPS software
package. Single beam only data will be collected by a Coastal Oceanographics HyPack MAX v0.5b
system for processing under the Caris HIPS/SIPS software package. During survey operations, no
physical offsets will be entered into the Isis system. Therefore, all offsets and corrections should be
handled by the Caris package. It should be noted that an average sound speed for the water column
and Side Scan “Horizontal Layback” will be input into the Isis raw data package. This information
will be discussed in the appropriate system sections.

With this in mind the following Reference Position was established based on the definition of a
Vessel Coordinate System provided in the HIPS User’s Guide.

Vessel Coordinate System
Vessel configuration is based upon an instantaneous, three-dimensional, vessel coordinate
system. The
Origin of the coordinate system is the reference position (RP). The axis is defined as follows:
The Y-axis is oriented along the vessel’s fore/aft axis, positive forward.
The X-axis is oriented along the vessel’s port/starboard axis, perpendicular to the Y-
axis, positive
to starboard.
The Z-axis is perpendicular to the X-Y plane, and positive down (into the water).

The Y-axis is located approximately mid ship at the fore/aft centerline created perpendicular to the
location of the A-Frame.

The X-axis is located at the approximate port/starboard center of the vessel.

The Z-axis was located at the rear deck level, slightly above the water line of the vessel during setup
and sea trials

Once this point was established, measurements were made to determine the physical offsets of all
survey equipment based on this coordinate system. These measurements were compiled and
displayed in the AutoCAD 2000 file called R/V Willing.dwg. This drawing contains all sensor
offsets.

During the establishment of system offsets a “Reference Mark” was set to aid in monitoring vessel

Static Draft. The Reference Marks are located on the starboard single beam transducer mount
vertical member, The distance from the Reference Mark to the Z-axis is 1.20 meters.

2.3 Monitoring Vessel Static Draft

To correctly process soundings, Caris needs to know the position of the Reference Point during
survey operations. This point will move as equipment load, personnel, and fuel levels change. To

Ocean Surveys, Inc.
GE Hudson River Geophysical SOP Page 30



OCEAN SURVEYS, INC.

compensate for these changes the Static Draft is monitored daily. At the start of every survey day
the motion sensor is monitored to determine vessel attitude and a measurement is made from the
Reference Mark to the present waterline. If the vessel is experiencing a roll bias, due to fuel load,
personnel are moved to steady the vessel at its standard attitude. This attitude was established during
sea trials, by approximating vessel loads and “zeroing” the motion sensor.

[ ]

. Appling Static Draft

The measurement is logged in the daily spreadsheet and is reduced to a static draft value that is
subtracted from the distance to the zero vertical reference and the difference entered in Caris.

[ ]

° Static Draft Variation

The Static Draft is monitored daily as mentioned above. The Static Draft of the vessel appears to
have a maximum deviation of 0.01 meters. The data to date is summarized below:

Static Draft
Fuel Load (meters)

Full 0.080
9 0.080
.8 0.080
7 0.079
.6 0.079
5 0.079
4 0.079
3 0.079
25 0.079

2.4 KTD File Development for RTK GPS Water Level Data Collection and Raw Data
Collection

We will be collecting RTK GPS water level elevations throughout the survey area and will be saving
them as water elevations referenced to the NAVD 88 datum. This requires the preparation and use
of a .KTD file. The KTD file models the difference between the ellipsoid height and the collection
datum (NAVD 88) throughout the site.

3.0 HYDROGRAPHER OPERATIONS

3.1 Start of Day - System Start-up and Dock Side Checks

Upon arrival to the vessel on a planned survey day, perform the following functions or verify
their occurrence. These items should be done every day before departure.
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e Start generator and switch system power from shore to generator.

e [f system was shut down the night before, turn on both UPS main power
switches and wait for the units to power up. Trip the TEST switch once on
both units to apply power to the outlets.

3.2 Start of Day — Electronics Systems Start-Up

Verify DC Mains, 448, 595, and Autopilot are off before powering up, or logging onto,
the computer systems.
Verify that the monitors are all off via the switch on the monitor outlet strip.
Power up the Triton Elics, NOAA 1 & NOAA 2 computers.
Turn on the monitors via the switch on the outlet strip.
Computer 1 & 2
= Log on using default Logon
e User Name osiuser
e Password (blank)
The Triton Elics machine is Windows 2000 and has no log on screen
Wait for all three computer systems to fully boot
Turn on DC Mains switch. This powers the DMS2i-05, 7400, T4000s, MX51s, CTD and
radio modem
Put the Autopilot in standby
o Observe compass = 244 - 250 degrees
Verify computer date/time on each system
e Open the H11032 vessel log.xls and enter the crew arrival time, vessel departure time,
and crew initials.

3.3 Start of Day - GPS Systems Check

Activate REMCON
o Select CLEAR to acknowledge power-up
o Select POSITION
= Verify Mode is RTK FIX
= Verify position
e Lat~355040.8
e Lon~753919.6
Minimize REMCON

3.4 Start of Day — Klein 595

Check mount
Check connector
Check cable and lock ring
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Check Fish body screws

Apply power to unit

Press “any” button to start system

Press enter once, and left arrow once to stop printer

3.5 Start of Day — Innerspace 448

e Verify paper supply in unit
e Set power to on to verify date and time — correct if necessary
e Set power back to standby
e Add Start of Day Annotation
o Registry #
o Julian Date
o Calendar Date
o Vessel
o Transducer in use
o Operators
o Roll#

3.6 Start of Day — Logging

Open Survey Log

Log date and personnel on board
Log WX observations at start of day
Log activities at dock

o 3.7 Start of Day — HYPACK MAX

e Open Explorer
e C(reate a folders in the HYPACK/PROJECTS//DATAT1/ folder with a naming scheme of
##H#MAX1 where ### is the Julian date of the survey day. (Daily survey directory) Create
a separate folder for each survey day.
e Start Hypack MAX
o Verify that correct Line File is Enabled
o Verify that correct background chart is enabled
o Verify Geodesy
e Start Survey
o Open Dialog box under Options/Project Options
= Set Project directory to the daily survey directory.
= Set the Target directory to the daily survey directory.
= Verify that the other information is correct and that Long Filenames are
enabled.
o Verify all alarms are off (except 448)
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o Verify that all equipment is in normal locations (generator, etc.)

o Ensure vessel is in Reference position. Have vessel captain move the vessel as
needed. In Survey, click on Targets, Select, and then Change File. Select the file
NAVCHK.TGT from the project directory. Select the dockside nav-check point
and right click on it to “select” target. Observe distance to target. If distance is
excessive. (Value +/- 1.5 meters) determine what the problem is and correct it.
Take a target (F5).

o Modify the target properties (F6) to name it XXX AM NAV CHK where XXX is
the Julian Date. Add entries in Comments section: Pitch X.X Roll XX Hdg
XXX.X in which you record the observed pitch, roll, and heading as observed at
the dock.

o Dockside Limits:

= Pitch 0.0 +/- .2
= Roll 0.0+/-.5
= Heading 246 +/-5 deg.

o Evaluate if values exceed the limits.

o Log the time in the “activity sheet” of the H11032 survey. Also, place an “x” in
the roll, pitch, and heading columns on the same sheet to indicate they have been
checked.

e Dockside static draft:

o Observe the ROLL value from the MRU and move people to normal positions
within the vessel, or as necessary to compensate for fuel load, to achieve a “zero”
roll while measuring the static draft from “Reference Mark™ to the water’s
surface. Record the measured value in survey log. Correct the measurement to
true static draft value with formula provided. Also note the RTK tide displayed on
the NOAA1 Hypack Max data display and enter it in the daily log sheet.

e Dockside RTK water level check

o Observe the local water level reading and enter it in the RTK vs. Observed section
of the daily log sheet. Compare the NAVD-88 value calculated by the log sheet
with the value recorded from Hypack Max.

° 3.8 Start of Day — ISIS

e Open Windows Explorer
e Verify space unavailable on data drive E: > 10 GB. If less than 10 GB you need to clear
out older (already archived) files to make space.
e (reate a new directory on that drive in the H11032 ISIS folder based on the following
format:
o XXXISIS - With X = to Julian day
e  Minimize Windows Explorer
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Start ISIS system from the H11032 ISIS shortcut. (This starts ISIS with the correct config
file)
o Set working directory for Isis under Configure>Hypack DDE> Start each
filename with to daily directory
o Set Target working directory under Tools>Target>File>Set Working Directory
Verify next contact number is set in Tools>Target> Edit>Set Contact Number
Set unit to Start Record to screen only- File>Start Recording>Display Only
Set Layback—View>Layback>Enter value>Accept
Set threshold in waterfall by right click—Threshold =1
Set waterfall window values as shown below
Open Sensor window- Windows>Status & Control>Sensors
If you want to view 448 depth - Aux 1 displays depth
Open Altitude window
Click on symbol of Alt: in Telemetry window of Parameter Display

Annotations
o Annotations are kept in a WordPad document name JD###. TXT where ### is the
Julian Date. This file is kept open on the Isis machine and annotations are copied
and “pasted” into the NOTE: section of the .XTF.
o SSS annotations must be recorded in the notes section of the Isis box at:
= Atstart of line
=  When surface objects are noted
=  When SS tuning, range, cable out, or any other parameters are changed

4.0 CONFIDENCE CHECKS

Confidence Checks H11032-JD160-06092002-RV WILLING II/PORT
Confidence Checks H11032-JD160-06092002-RV WILLING II/STBD
Confidence Checks H11032-JD160-06092002-RV WILLING II/BOTH

Registry#/Julian Date/Calendar day/Towing Vessel/Channel

5.0 INTERFERENCE

H11032-JD160-06092002-RV WILLING II/Wake
H11032-JD160-06092002-RV WILLING II/Biologic

Registry#/Julian Date/Calendar day/Towing Vessel/Type of Interference
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o 6.0 DURING TRANSIT TO SITE

Ensure the shore power cable is stowed.
Remove all dock lines and depart.

7.0 ON-SITE — PRIOR TO SURVEYING

Determine sound velocity and enter into machines

Isis — Configure/Sound Velocity

Hypack Max — Options/Navigation/Roxann Sound Velocity
Innerspace 448 — Dial in as Speed of Sound

Bar Check

Depth confidence check

Deploy SSS for appropriate tow

Check SSS Range

7.1 Daily Average Speed of Sound

Obtain speed of sound readings. Enter in 448, Isis, and in HYPACK MAX -
Survey, under OPTIONS, Navigation Parameters as “Roxann Sound Vel.
Verify value is representative of prior values.

° 7.2 BAR Check (Depth)

Verify that the average speed of sound from the days first cast is entered into
the 448

Lower the barcheck to the lowest 1.0 meter increment available referencing
the 1 meter marks to the 448 draft mark on the transducer vertical pole.

Start the 448 paper and record the bar at one meter intervals to 1.0 meters.

° 7.3 Confidence Check (Depth)

Check 448 to insure correct sound velocity entered, draft=0.0, tide=0. Mode
Auto, gate 4, replies 8. Turn 448 from STBY to ON just prior to check to
record date, time, speed of sound, and draft on paper record.

Record depth on paper record as Hydrographer lowers bar to seafloor. On the
“MARK” given by the hydrographer as the bar is touching the seafloor, toggle
the FIX MARK switch on the 448. The hydrographer will measure the
distance from the seafloor to the water surface using the barcheck marks and
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by measuring between marks. Take target.(F5) Name target XXX Depth
Confidence Check. Return 448 to STBY mode.
e Annotate paper record with:
o Depth Confidence Check
H11032
Julian Date XXX
Operator Initials
Bar Check = X. X m (meters)
Calculated 448 depth by adding displayed depth to daily static draft.

O O O 0O

7.4 Confidence Check (Sidescan)

e While collecting data:

e [SIS operator will enter the appropriate annotation into the NOTE: section of
the .XTF while online. The time is entered into the daily log and noted as a
confidence check .

e At times other than during regular data collection

e A line can be run outside of regular data collection to demonstrate that the
sidescan sonar system is able to detect targets out to the full extent of the
selected range. The Hypack operator selects line 900 to record the data. The
XTE value in Survey/Options/Navigation Parameters should be changed to
200000 to avoid unnecessary TEXT log entries. Start the line when ISIS is
ready.

o 8.0 BEFORE ON LINE DATA COLLECTION

8.1 Computer 1 - Hypack Max

Start Survey
Verify correct line entered, and line azimuth is correct. Change if necessary.

8.2 Computer 2 - Hypack Max

Start Survey — start logging prior to BOL.

8.3 Innerspace 448

Turn 448 alarms on (if off) — verify digital depth is ok Start Paper
8.4 ISIS

Verify ISIS is ready.
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8.5 Heave
Verify Heave is ready.

Create a target (F5) and change it’s properties (F6) to DECK CTD = XXXX.X. (The value
observed at the beginning of line)

9.0 START OF LINE

e Save / Clear any contacts in the Target window
e Verify SSS data quality and bottom track prior to start
e Verify coastal line start of Isis

o Watch file size increment

o Check destination directory for file

J 10.0 ONLINE
Observe digital depths, heave, and profile window to verify proper operation. In shallow areas assist
the vessel helmsman by closely monitoring the depth of water. Immediately notify helmsman of

hazardous condition. Watch water depth to QA/QC alt. of SSS. Watch vessel speed.

Observe Sidescan record in Isis. Mark targets & put target in Hypack so as to allow checking the
target on the next pass.

Periodically observe Deck CTD value, DIM value, heave, vessel speed, and CTD time interval.
Observe Navigation map for holes in Isis.

° 10.1 Gap Tracking - Sidescan

If a condition is observed that may create a gap in the Sidescan data the operator hits F5 on
Computer 1 to create target. The operator then evaluates further. If a gap is declared the target will
be called up for modification (F6). The default name in the target name field will be changed to
XXX SS GAP; where XXX is the julian date. Further info will be entered into the notes field as
follows:

Start & end time of gap, channel (port/stbd) Line designation

Example:

034 SS GAP

Notes: 16:37:00 to 16:37:45, Port Channel, Line 201 1549.034, type of interference

Ensure that Gap is entered in H11032 daily log.

10.2 Gap Tracking - Singlebeam
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Hypack operator hits F5 and creates a target as SB gap is seen. Operator modifies target (F6) to
change name to XXX SB GAP. (XXX is the Julian date) Ensure that Gap is entered in survey daily
log file.

o 11.0 END OF LINE

e Save all contacts as follows, and report final contact number in log
o Target>File>Save All>Yes if not saved already

12.0 END OF DAY

Review ASCII text file for alarms

12.1 End Of Day - ISIS

e Exit from Isis
e C(lose Target window if still active
e Log off machine or shut down based on required backup situation

12.2 Archiving Procedure

e Data from all sources is colleted in Computer 1archive for archiving and data transmittal
preparation

e A separate directory is established for each survey day with a subdirectory structure
where each type of data is stored

e The structure and file types are outlines below

DIRECTORY NAME FILE NAMES
XXX Data\Docs All documents H11032 Survey Summary of all
created Log . XLS activities

Willing Vessel layout and
Il offsets 1 19.DWG | system offsets

XXX Data\XXXisis All Isis data files | *.XTF All . XTF files from
XXX.LOG the day
* CON, XXX-00- Daily Isis survey log
contact. TXT Original Isis contact

files
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XXX Data\Max_ Support Hypack MAX Varied file types Setup and support files
support files for Hypack MAX
operation
Hypack MAX
operations and alarms
summary
NI files used for
MAX
XXX Data\XXXmax1 Hypack MAX * RAW All Hypack data lines
data files and .log | *. TGT TGT i1s MAX target
file file

e A directory template is available with all subdirectories established with an XXX, copy

this template to Computer 1 and replace XXX with Julian day.
e Removable Hard Drive

o A copy of each days data are copied from Computer 1 to a removable hard drive
at the end of each survey day.
o The Drive is then taken to the project office where the data is archived.

e XTF Data

o Move the survey log from D:\root to daily directory at the end of the survey day

e Hypack Data

o Copy both the TGT and the TXT file for the day to the data archive.

e Document Files

o Copy the Daily Survey Log to the Daily Directory Doc section
o Copy the Master Log.XLS to the Daily Directory Doc section
o Copy any other relevant documents or drawings to this section

e Misc Section

o Place any other non-standard files into this directory.

° 12.3 End of Day: System Shut Down and Dock Side Checks

Upon arrival at the dock, perform the following functions or verify their occurrence. These items
should be done every day before departure from the vessel.

e Secure all dock lines and hook up the shore power cable upon arrival at the dock, log
arrival time in vessel log.

e Read the vessel fuel gauge and enter the value in “Activities Section” of Daily Log

e (apacity is approximately 120 gallons
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e Ensure vessel has all appropriate supplies for the next day. Fuel, disks, FEDEX
supplies, food, paper supplies, and water.

Switch the system over to shore power after verify unneeded systems are off.
Turn off the DC Mains and Autopilot.

Verify you have the Data package and any files that will be e-mailed with you.
Ensure all lights and boat electronics are off. Check all windows. Ensure bilge
pumps are on. Lock back door upon departure.

12.4 Misc. System Operations

o 12.4.1 Klein 595

e Lower fish into the water to test operation

e Deploy fish and note cable out for layback calculations.
e Verify SSS image quality on Isis

e End of Day
o Power Off
o Recover Fish
o Inspect entire wet end of system for wear — damage

° 12.4.2 Innerspace 448

e On-site
o Input average speed of sound from first SVP and verify entry into all other
systems
= 448 — Hypack — Isis
e Start of Line
o Alarm on
e Good bottom lock
o Verify range, gain, mode, and gate settings for upcoming line conditions.
o Verify proper sound velocity based on first cast
o Unit in standby power unless performing confidence check or time check

e End of day

Turn unit off

Remove and archive sounding roll
Verify Sounding pole is raised
Verify paper supply on board

O O 0O

Periodic Maintenance
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o Clean print head
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